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Voxel Based Morphometry Tutorial using the
Geodesic Shooting Toolbox

Requirements:
* T1w MRI data for two groups (suggest ~10 subjects in each group)
* Basic demographic details for each subject (Age, Gender + any other
covariates)
* MATLAB running SPM12. Make sure SPM12 and all subdirectories is in
the MATLAB path (test by typing “which spm” in MATLAB prompt)

Overview:

This tutorial will go through the full processing pipeline for a two group VBM
analysis using the Geodesic Shooting toolbox in SPM. The full analysis, depending
on your computer, will take ~6h to run. If this is a live demo, then sub-select
three datasets to test, and then set up the full analysis in your own time.

VBM_mini > sub-001 > anat > sub-001_T1w.nii
sub-002 >
sub-003 >

The basic objective is to generate smooth warped modulated tissue classes from
T1w MRI data in the native subject space, and used these warped images for a
GLM analysis. To achieve this, we need to pre-process the data in several distinct
steps that can be broadly divided into:

1. Data preparation
2. Structural pre-processing

3. Analysis
A. PREPARATION B. STRUCTURAL PRE-PROCESSING C. ANALYSIS
DICOM
import
MRLnii _py B SHOOT—g— WARP — MODEL | ANALYSIS &
files SEGMENT SHOO R DESIGN VISUALISATION
BIDS /
directory
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A. DATA PREPARATION

1. Setting up the directory structure

Neuroimaging experiments result in complicated data that can be arranged in
many different ways. Historically, individuals have tended to use their own
unique naming/directory structures. The “Brain Imaging Data Structure” (BIDS)
Specification has been designed to standardise this to help others understand the
data, aiding replication, data-sharing and collaborations. For more details see:
https://bids.neuroimaging.io/bids_spec1.0.0-rc2.pdf

For this demo, we will use the anatomical and naming convention as per BIDS:
[some path]/vbmdemo/group-01/sub-001/anat/

See the end of this section for a code snippit to combine this with dicom import.
2. DICOM import

Normally, MRI data comes from the scanner in dicom file format (.dcm). To use
this we first need to import the data and convert it into nifti file format. It is

preferable to use “single file nifti format” rather than two-file (.img & .hdr).

Dicom import is located on the main SPM menu:

| Real. 7| Smooth !
| Nor.. « |
| Cor.. B | Segment
Basic models Review
Estimate Bayesian

‘ Results ‘

Dapiay ||| CreckRe || R.. 3| [*J

T, A PPls ImCalc DICOM Import

v

Help U. 4 Batch Quit

This will open up a GUI, where you can select the .dcm data, output directory
and output file format.
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Module List Current Module: DICOM Import
DICOM Import <X Help on: DICOM Import
DICOM files <X
Directory structure for converted files No directory hierarchy
Output directory <X
Protocol name filter S
Conversion options
. Output image format Single file (nii) NIfTI
. Use ICEDims in filename No

Current Item: Output image format

Two file ilﬁi—hﬁ NIfTI

Obviously this could get a bit tedious with lots of data, so the easiest thing is to
write a short section of code to do this. A really useful function in SPM is the
View -> Show .m code:

[ NON ) Batch Editor
File Edit m SPM BasiclO ~
D  d Update View #U
Modueist  Change Font/Fontsize 3F
Expert Edit RE
Sh Cod %S <X
i, converted files No directory hierarchy
Output directory <X

Protocol name filter

Conversion options

. Output image format Single file (nii) NIfTI
. Use ICEDims in filename No

This will open a window with the corresponding code for that function. You can
then copy and paste it into your own script. Over is a short example for the data
import. [ have modified it a bit to restructure the data following BIDs.
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$Modify naming as required:

study="'vbmdemo/ ' ;$Study

group{l}='group-01/'; %subgroupl - For simplicity with analysis
group{2}='group-02/"; %subgroup2

$Select path
OP=spm_select(l, 'dir', 'Select path/location to build data
directory');

$Some BIDS stuff
sub="'sub-00n/"';%subject numbering (N will be 1 -> max)
bidsanatomy='/anat/'; %bids anatomy format

X{1l}=spm select(inf, 'dir', 'Directories containing GROUP1l .dcm');
X{2}=spm_select(inf, 'dir', 'Directories containing GROUP2 .dcm');

for j=1:2
for i=l:size(X{j},1);
target=char(strcat(OP,'/',study,group{j},sub(l:end-
2),num2str(i),bidsanatomy));
mkdir(target);
clear matlabbatch
$Select dicom data in directory
data=spm_select('FPListRec',deblank(X{j}(i,:)),"'.*.dcm");

$This was copied from show .m code, and the variables above
plugged in
matlabbatch{l}.spm.util.import.dicom.data = cellstr(data);

matlabbatch{l}.spm.util.import.dicom.root = 'flat';
matlabbatch{l}.spm.util.import.dicom.outdir = cellstr(target);
matlabbatch{l}.spm.util.import.dicom.protfilter = '.*';
matlabbatch{l}.spm.util.import.dicom.convopts.format = 'nii';

matlabbatch{l}.spm.util.import.dicom.convopts.icedims = 0;

$Command to make matlabbatch run in spm
spm_jobman( 'run',matlabbatch)

$Now need to rename output to be consistent with BIDS
NiiFile=spm select('FPList',target,’'.nii');
newfilename=char(strcat(target,sub(l:end-

2),num2str(i), ' Tlw.nii'));
movefile(NiiFile,newfilename);

end

end

clear X group sub bidsanatomy data matlabbatch target study
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B. STRUCTURAL PRE-PROCESSING

Here is an overview of the structural pre-processing steps we are aiming to

achieve:
! 1. SEGMENT 2.SHOOT 3. WARPING (push-forward)
= ) — INPUTS: . INPUTS: —_— INPUTS:
5 ‘ 1 Tlw MRI Dartel import GM (rcl) Deformation field (y_)
K & Dartel import WM (rc2) Native GM (c1)
LA Select the following options: Dartel import CSF (rc3) Native WM (c2)
“Native and Dartel import” Template 4

“Save Bias Corrected T1w MRI”

Select the following options:
“New Inverse”
-> Composition deformation

“Output pushforward”
-> Preserve Amount (Modulate)
-> Smooth [6 6 6]

**IMPORTANT BEFORE STARTING**

While the spm pipelines do an excellent job of combining and realigning data,
they do rely on the source data (i.e. all of the T1w MRIs in native subject space)
being in reasonably close alignment to one another.

Before starting any analysis, you should ALWAYs visually check your data. This is
by far and away the most common source of errors/mistakes, and it is much
easier to correct at the start.

To do this, use the “Check Registration” function in the spm main menu. You can
select up to 24 images at a time:

: File Edit View Insert Tools Desktop Window SPM Figur« Help

Results

Dspay 3y

T s ‘ DICOM Import

In the example above, we can see that the bottom right MRI is very poorly
aligned with the rest. This is unlikely to be successfully processed and may cause
problems later. It is easier to manually realign images like these at the start.
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To do this, right click on the MRI with the issue, and select “Re-orientate image”

and “Current image” from the menu:

[ Nor.. %]

| Real. %]
Segment

Smooth ‘

| cor. %

Estimate

Basic models
Bayesian

Revw ‘

| Results |

M |

R. ¥ m—

ImCalc DICOM Import

sub-003_T1w.nii,1,1

mm: 2.319.83.0
vx: 144.6 140.2 81.5
Y = 343.947

Batch Quit

Zoom

v Crosshairs
Orientation
Snap to Grid
Interpolation

Image
Overlay

Browse...
Contour

Display

Goto maximum
Movie

Reorient image(s)

RGB overlays
ROI tool

w SaveAs...

+ File Edit View Insert Tools Desktop Window SPM Figur¢ Help

>

>

>

>

>

>

>

>

2 All images

>
> Set origin to Xhairs

» Help |
» jim 5[ untitled® [ untit
> i

—H

This will open a window with 9 affine transforms you can manually specify until
you have reasonably good alignment. Then just “Apply to images”. It is a good

idea to store the transformation matrix for reference.

: File Edit View Insert Tools Desktop Window SPM Figur¢ Help
| Real. %] Smooth
= | Nor. %]

[ cor. 3| = Segment
Basic models Review
Estimate Bayesian
{ Results J
Display Check Reg R.. + ——
T. 4 PPis imCalc DICOM Import
Help U. 3 Batch Quit
right {mm} o
forward {mm} 60
vp {mm} o
pitch {rad) 0.6
roll {rad) 02
yaw {rad) 02
resize {x} 1
resize {y} 1
resize {z} 1
#contour lines. 3

| Transtation(1) Rotation2) Zoom(3)
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1. SEGMENTATION

Assuming your data has been successfully imported, you have checked it for any
problems and corrected any issues, the next step is to segment the brain into
different tissue types. SPM12 will produce up to six tissues:

* cl - Grey Matter

* c2 - White Matter

e c3-CSF

* ¢4 -Bone

* ¢5 - Soft tissue

* c6 - Everything else

For VBM, we are interested in analyzing the grey and white matter. In these
processing steps, we will also include the CSF for generating the group template,

brain mask, and calculating total intracranial volume.

First select Segment from the SPM menu:

SPM12 (6906): Menu

s wdh (ud VUV WA WV
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This will open up the Segment batch menu. There are a lot of options available
that we will not explore here.

First double click on volumes. This will open a file select box, where we will
select all of the T1w images we want to analyse:

Dir /Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo

Up /Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo v

Prev /Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo v

x {

group-01

group-02 !
|
|

[ Done | Filter * nii ,

Frames 1 :

Selected 0/[1-...] files. (Initial selection.)

/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo/group-01/sub-001/anat/sub-
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo/group-01/sub-002/anat/sub-
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo/group-01/sub-003/anat/sub-
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo/group-01/sub-004/anat/sub-
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/vbmdemo/group-02/sub-001/anat/sub-

Rather than selecting each file manually, you can speed this up using recursive
search (shown above). At the end of the filter add .nii (to specify you want to
look for all of the nifti files within the directories above) and then hit Rec
(arrow). We will use this again later with other file specifiers.

You will now need to modify the following options (summarized on the figure
over):
* Save Bias Corrected: Change to Save bias corrected (for making group
average brain to project results on later).
* Native Tissue: Native and Dartel imported for tissue classes 1-3
* Native Tissue: None for tissue classes 4-6
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Ded P

+ Maodule: S o

Module List Cu
Segment

Help on: Segment
Data

.Channel

.. Volumes

.. Bias regularisation
.. Bias FWHM

.. Save Bias Corrected
Tissues

. Tissue

.. Tissue probability map ...

.. Num. Gaussians
.. Native Tissue

.. Warped Tissue

. Tissue

.. Tissue probability map ...

.. Num. Gaussians
.. Native Tissue

.. Warped Tissue

. Tissue

.. Tissue probability map ..

.. Num. Gaussians
.. Native Tissue

.. Warped Tissue

. Tissue

.. Tissue probability map ...

.. Num. Gaussians
.. Native Tissue

.. Warped Tissue

. Tissue

| .. Tissue probability map ...

.. Num. Gaussians
.. Native Tissue

.. Warped Tissue

. Tissue

.. Tissue probability map ...

.. Num. Gaussians
.. Native Tissue
.. Warped Tissue
[ Warping & MRF
I . MRF Parameter
.Clean Up
| . Warping Regularisation
| . Affine Regularisation
. Smoothness
. Sampling distance
. Deformation Fields

Current Item: Native Tissue

16 files (@ m—

light regularisation (0.001)
60mm cutoff

Save Bias Corrected () —

ns/Matlab Toolboxes/spm12-2017/tpm/TPM.nii,1

1
Native + Dartel Imported _

None

ns/Matlab Toolboxes/spm12-2017/tpm/TPM.nii,2
1
Native + Dartel Imported _

None

.ns/Matlab Toolboxes/spm12-2017/tpm/TPM.nii,3

2
Native + Dartel Imported () m—

None

ns/Matlab Toolboxes/spm12-2017/tpm/TPM.nii 4
3
None _

None

ns/Matlab Toolboxes/spm12-2017/tpm/TPM.nii,5
4

None
None

ns/Matlab Toolboxes/spm12-2017/tpm/TPM.nii,6
2

None _

None

1
Light Clean
1x5 double
ICBM space template - European brains
0
3
None

Native Space
Dartel Imported
Native + Dartel Imported

The native space option allows you to produce a tissue class image (c*) that is in alignment with the original. It
can also be used for “importing" into a form that can be used with the Dartel toolbox (rc).

One of the following options must be selected:

* Native + Dartel Imported

Above: Summary of Segment settings. Note this is a merged image and you

will need to scroll down to see all the options.
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Before processing the data, it is a good idea to save the batch incase you need to
re-do/check again later.

SAVE GO

\Edu V/SPM BasiclO
Ded P

Module List Current Module: Segment

Segment Help on: Segment

This may take a little while to complete, depending on the size of your dataset
and computer. The output in each file directory will be:

* cl[filename].nii - Native space grey matter segmentation

* c2[filename].nii - Native space white matter segmentation

* c3[filename].nii - Native space CSF segmentation

* rcl[filename].nii - Dartel import space grey matter segmentation

* rc2[filename].nii - Dartel import space white matter segmentation

* rc3|[filename].nii - Dartel import space CSF segmentation

* m[filename].nii - Native space bias corrected T1w

* [filename]_seg8.mat - Various normalization transform data

Below is a figure showing native c1 (left) and dartel import (right)
segmentations. Basically, dartel import is orientated (rigidly aligned) with MNI
space, meaning every subject’s data is in reasonably close alignment with one
another which will help produce better results using the warping algorithms.

** It is a good idea to visually check your segmentation results for
errors/problems at this stage before moving onto Shoot.**

10
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2.SHOOT

Geodesic shooting is a diffeomorphic warping algorithm designed to non-linearly
align the brain data. It has recently been developed building on the earlier
“Dartel” pipeline. As such, it does not yet have as many additional functions
compared to Dartel (e.g. Normalise to MNI space, warp many etc.,), and
therefore requires some additional manual steps to use (covered here).
However, the overall impression is that it is better than Dartel and will be
increasingly used in the future, therefore it is the pipeline used here.

To use, first open the SPM batch window:

SPM12 (6906): Menu

11



Christian Lambert
July 2018

From there, you want to select:
* SPM - Tools - Shoot Tools - Run Shooting (Create Templates)

[ oKX ) Batch Editor
H= % | File Edit View YN BasiclO
Temporal >
Module List Spatial > e
Stats . m
0 Modules in Batcl DCM S |eCt
M/EEG > Analyze Code
util » Run and Time
Brainstem >
Dartel Tools >
Edit Defaults FieldMa > = 0,
T { van . DMPLETED » adhi
Longitudinal Registration » =
Old Normalise >
Old Segment e
9 4x4 double
PPMI Tc_bulbox > 1x1 struct
Rendering > £ 1v12 dnuhla
Shoot Tools > Run Shooting (create Templates)
Shoot Tools > Run Shoot (existing Templates)
SUIT > Kernel Utilities >
I it
1x1 cell
6x1 struct
4-D single
1x1x13 doub
ory
e=char(strcat(
iiFile,newfilel

pup sub bidsani

MATLAB Batch System
labbatch User Interface

E‘

LS_4660-0401-0
* Menu and Toolbar

The "File" and "Edit" menu offer options to load, save and run a job and to modify the configuration of the batch
L system. For each application which is known to the batch system, a separate pulldown menu lists the available

modules. Depending on the application, these modules may be grouped into submenus. Application specific
defaults can be edited by choosil

ing "Edit Defaults” from the ication menu. The toolbar offers some shortcuts

This will open up the Shoot batch window:

File Edit View SPM BasiclO ¥
D E P
Module List Current Run Sh. g (create
Help on: Run Shooting (create Templates)
Images
. Images <X
. Images <X
. Images <X

Current ltem: Images

Replicate: Images (1!

Replicate: Images (2)
Replicate: Images (3)
Delete: Images (1)
Delete: Images (2)
Delete: Images (3)

Click on “New: Images” (arrow) for each tissue class you are going to use for
generating the population average template. Here I am going to use GM, WM and
CSF so I create three “Images” channels.

12
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Now double click on each image channel to add the data. Here you will need to
select your “Dartel Import” tissue classes. Again I'm going to use recursive search
by typing:

Arcl.*
And pressing Rec (arrow). This will find all the GM. Then click done.

Repeat this process for the remaining two channels, using *rc2.* for WM and
~rc3.* for CSF.

Dir ' /Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLETED/adni2_t/
Up | /Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLET... =+ |
Prev | /Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLET... = |

sub-001
sub-002
sub-003
sub-004
sub-005
sub-006
sub-007
sub-008
sub-009
sub-010

B | Done | Filter | Arcl.”

Frames 1
Selected 0/[1-...] files. (Initial selection.)

/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLETED/adni2_baseline/ad/s
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLETED/adni2_baseline/ad/s
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLETED/adni2_baseline/ad/s
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLETED/adni2_baseline/ad/s
/Users/christianlambert/Documents/MY_DATA/SPM_DEMOs/VBM_COMPLETED/adni2_baseline/ad/s

When you inputted the data correctly, the arrow should go green. Again it is
sensible to save your batch at this stage.

DEE b |
Module List Current Module: Run Shooting (create Templates) |
Run Shooting (create Tem Help on: Run Shooting (create Templates)

Images

. Images 10 files
. Images 10 files
. Images 10 files

This is the slowest part of the entire pipeline, and may take hours-days
depending on data size/computer.

13
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The output in each file directory will be:
* y_rcl[filename].nii - Deformation field
* j_rcl[filename].nii - Jacobian determinants
e v_rcl[filename].nii - Velocity field

Additionally, in the first directory you will find five Template images (0-4). These
are 4D files (containing GM, WM, CSF, Other) showing various stages in
estimating the POPULATION AVERAGE:

TEMPLATE 0 TEMPLATE 1 TEMPLATE 2 TEMPLATE 3 TEMPLATE 4

START P FINISH

Importantly, this process estimates a POPULATION AVERAGE TEMPLATE. This is
a type of group average space that is unique to your study population. This is
NOT MNI space (MNI is a type of population average space), however it will be
very close.

You can do and publish your entire analysis in your
specific population average space.

If you really want your results in MNI space (e.g. for data-sharing results
maps/coordinates), you can do this using the Co-registration function (MNI =
reference, population average = source, other = Any results/data you want to
move to MNI).

14
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2. WARPING
To analyse our brain data, we need to warp it to the group average space. To do
this, we will use the deformation fields (y_[filename].nii) we have just generated

using the Shoot Toobox.

To do this, we need to open the spm batch menu again

® ® @ SPM12 (6906): Menu

15
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From here we need to select:
e SPM -> Util -> Deformations

[ ] [ ] Batch Editor
| File Edit View ESJIM BasiclO ¥
Ded & Temporal > L
| Module List Spatial > dule
| DI Batch -‘I‘;é‘;j " |
M/EEG >
Display Image
Tools > Check Registration
1 o
| . Rendering >
1 Edit Dgfaults Import > :
‘ Image Calculator F
| ]

Reorient Images

Volume of Interest

Get Bounding Box

De-face Images

Tissue Volumes
1 Print figure
3D to 4D File Conversion
4D to 3D File Conversion
Expand image frames
Sendmail

This will provide a menu with a LOT of options for normalizing data. The
approach we will use is called “Push-forward”. This has the advantage that we
can also simultaneously modulate and smooth the data, cutting down the
number of steps we have to do.

To use push-forward, we need to select:

Composition: New Inverse (this will add a new submenu)
Inverse

-Composition: New Deformation

---> Deformation Field: Input the y_[filename].nii
---> [mage to base inverse on: Input Template_4.nii

Output: New Pushforward (this will add a new submenu)

Pushforward

-Apply to: Put in image(s) to be warped (i.e. c1 and c2, NOT dartel import)
--> Output destination: Source directory

--> Field of view: Image Defined (this will add a new submenu)

----- >Image Defined: Input Template_4.nii

--> Preserve: Preserve Amount (“Modulation”)

--> Gaussian FWHM: [6 6 6] (smoothing kernel)

This is summarized in the figure over

16
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File Edit View SPM BasiclO 3
D d b

Module List Current Module: Deformations

Help on: Deformations
Composition
. Inverse
.. Composition
... Deformation Field ..5_4660-0401-00004-000001-01_Template.nii
.. Image to base inverse on ..._baseline/ad/sub-001/anat/spm/Template_4.nii
Output
. Pushforward
.. Apply to ..1Z_s130_S_4660-0401-00004-000001-01.nii
.. Weight Image
.. Output destination
... Source directories
.. Field of View
... Image Defined ..._baseline/ad/sub-001/anat/spm/Template_4.nii
.. Preserve Preserve Amount ("modulation”)
.. Gaussian FWHM [6 6 6]
.. Filename Prefix "

Current Item: Gaussian FWHM

666

Specify...

Save the batch. When you hit go, it should output smw[inputfilename].nii files in
the folder containing the MRI data. This is the Smoothed Modulated Warped
images that you will use for your VBM analysis:

Repeating this for every subject would be a bit tedious. Unfortunately there is
not yet an “apply to many” option for this (though may be soon). Attached is a
script to do that for you for now. Copy and paste into a blank script, save as
spm_warpshoot, make sure it is in your path and simply type “spm_warpshoot”
to run. This can also be used to create a group average brain (with adaptations,
detailed later).

17
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function spm warpshoot

%Geodesic shooting does not currently have a GUI for warping many
subjects

$This is a simple wrapper script to help.

>3

>3

$Just check number of tissue classes to normalise

answer = inputdlg('Number of tissue classes (default 2)','INPUT');
if isempty(str2num(answer{l})),classes=2;else
classes=str2num(answer{l});end

$Modulate or not

answer = inputdlg('Modulate (0 = No, 1 = Yes, default YES)', 'INPUT');
if isempty(str2num(answer{l})),mod=1;else mod=str2num(answer{l});end
if mod~=1,mod=0;end %$Make sure no silly inputs

answer = inputdlg('Smoothing FWHM (default 0 0 0)', 'INPUT');
if isempty(str2num(answer{l})),fwhm=[0 0 0];else
fwhm=str2num(answer{l});end

$SELECT WARP FIELDS:
W=spm_select(inf, 'any', 'INPUT WARP FIELDS');Sw=size(W,1);
T=spm_select(1l, 'any', 'TARGET TEMPLATE');

¢Now select INPUTS SEGMENTATIONS:
for i=l:classes
S{i}=spm select(inf, 'any',char(strcat('Input tissue
class',32,num2str(i))));
end

for i=1:Sw,
INPUT=deblank(S{1}(i,:));[OP,~,~]=fileparts(INPUT);clear
matlabbatch

if classes>1
for j=2:classes, INPUT=char (INPUT,deblank(S{j}(i,:)));end
end

matlabbatch{l}.spm.util.defs.comp{l}.inv.comp{l}.def =
cellstr(deblank(W(i,:)));
matlabbatch{l}.spm.util.defs.comp{l}.inv.space = cellstr(T);
matlabbatch{l}.spm.util.defs.out{1l}.push.fnames = cellstr(INPUT);
matlabbatch{l}.spm.util.defs.out{1l}.push.weight = {''};
matlabbatch{l}.spm.util.defs.out{1l}.push.savedir.saveusr =
cellstr(OP);
matlabbatch{l}.spm.util.defs.out{1l}.push.fov.file = cellstr(T);
matlabbatch{l}.spm.util.defs.out{1l}.push.preserve = mod;
matlabbatch{l}.spm.util.defs.out{1}.push.fwhm = fwhm;
matlabbatch{l}.spm.util.defs.out{1}.push.prefix = "'';
spm_jobman( 'run',matlabbatch);
end
end

18
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C. ANALYSIS

If you have got to this stage, then hopefully in every subjects folder you have a
swm{|tissue-class][filename].nii

Before we construct a model, we will need one additional covariate in addition
to those we already have for our study population - Total intracranial volume

In SPM, there is a function to do this. Open the batch menu:
¢ SPM -> Util -> Tissue Volumes

[ NON ) Batch Editor
File Edit View [EJJU Basict0 ~
Ded P Temporal »
Module List ~ Spatial P L Tissue Volumes
m— oo Stats >
Tissue Volumes ue Volumes
DCM > ) mat-files 20 files
M/EEG » sueclass 3
Display Image
Tools > Check Registration
i Rendering >
Edll( Dlefaults Import >
Image Calculator
Reorient Images
Volume of Interest
Get Bounding Box
De-face Images
Deformations
Print figure
~ 3Dto 4DFile Conversion [
i 4Dto 39 File Conversion
W Cxpand image frames ™
Sendmail
Specify... |
Output file

Filename for saving results. Segmentation filenames and volumes will be stored in CSV format
(cc i vari

This can be empty; results will appear in the MATLAB command window.
A String is entered.
The character array may have arbitrary size.

You will need to input the seg8.mat from the segmentation steps earlier.
Recursively search using .*seg8.mat

Module List Current Module: Tissue Volumes

Tissue Volumes Help on: Tissue Volumes
Segmentation mat-files 20 files
Maximum tissue class 3
Mask image ...atlab Toolboxes/spm12-2017/tpm/mask_ICV.nii,1
Qutput file my_tissue_volumes

It will either output in MATLAB prompt, or if you specify a file it will generate a
.csv you can use in excel. You will need to sum the three tissue classes (GM, WM,
CSF) to obtain a volume in litres for each subject.
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1. MODEL

First make a new directory for your specific analysis. You will need one directory
for each analysis you do.

Then from the SPM menu, select “Basic Models”

SPM12 (6906): Menu

=} =
(o 3] e

mmt

'—\ -

The precise set-up will depend on your study. Over [ have provided an example
for a two-sample T-test, controlling for age, gender and total intracranial volume.
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File Edit View SPM BasiclO >
D E P
Module List Current Module: Factorial design specification
Help on: Factorial design specification
Directory ...OMPLETED/adni2_baseline/GM_VBM @ Analysi S directory
Design ..
-Tgro-sa:\p'et-tat o—— Specify e T Group 1 smw{dataﬁle}.mz
..Group 1 scans 1165 Qe i
" Group 2 s e Group 2 smw|[datdfile].nii
.. Independence Yes
.. Variance Unequal
.. Grand mean scaling No
..ANCOVA No
Covariates
. Covariate .
... Vector 20x1 double @—— Age covariates
..Name AGE &= Name it
.. In(eraqions None . X
- Sentering Overall mean e——Specify it will be mean centered
... Vector 20X1 dOUDIE @ i
o i _%nder.tcovarzates
.. Interactions None amei
- Centering No centering e—— Specify it will be NOT be centered
. Covariate
eor 20x1 dounte e——Total intracranial volumes
.. Interactions None Name i
i Covtates Overallmean e—— Specify it will be mean centered
Masking
. Threshold masking
..None
. Implicit Mask ) Yes
- Explicit Mask @——— If [ calculate a brain mask
Global calculation .
. Omit Enter it here
Global normalisation
. Overall grand mean scaling
..No
. Normalisation None
Current Item: Centering
Factor 1 mean
Factor 2 mean
Factor 3 mean
No centering
User specified value
As implied by ANCOVA
Centering, in the simplest case, refers to subtracting the mean (central) value from the covariate values, which is
to thy with respect to the constant column.
from the beta for the term, but not that for the covariate. In

the simplest case, centering a covariate in a simple regression leaves the slope unchanged, but converts the
intercept from being the modelled value when the covariate was zero, to being the modelled value at the mean of
the covariate, which is often more easily For th value at thy mean age
is usually more than th value at an age of zero.

Again save your batch before proceeding. If you have done everything right, you
will see the design matrix corresponding to your model (see next page). Now
select “Estimate” from the SPM menu, select the SPM.mat in the folder you are
using, and hit go.
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File Edit View Insert Tools Desktop Window SPM Figur¢ Help

Statistical analysis: Design

. 5_46400400-00004- 000001 01 1, 1
-S5_47300400-00004- 000001 01 1, 1
- S5_4571 040000004 - 000001 01 o, 1
.5 4582040100004 - 000001 01 11, )
-5_4584-0400-00004 - 000001 01 11, 1
-5_4590-0401- 00004 - 000001 01 1, 1
- 5_4597 040000004 - 000001 01 1, 1
.5 3006040100004 - 00000101 11, )
w -5 3095040000004 - 000001 01 1, 1
& .5 5231040000004 - 000001 01 11,0
g .5_44450400-00004 - 000001 01 11
- L 065 _41300401-00004 - 000001 i,

-5 _431370003-00001 - 00017601 1, 1
-5_44850301-00005- 000001 01 1, 1
L 065 _4130-0400- 00004 - 00000 1 1,
-5_4157 040000004 - 000001 01 o1, 1
-5_4445-0400-00004 - 000001 01 1, 1
-5_44850301-00005- 000001 01 o1, 1
.5 _431370003-00001 - 00017601 1, 1

.5 _41820003-00001- 00017601 1, 0

T

parameters

{Fy — Jnot uvguely specifsed)

parameter estimability

Design description. ..

Design : Two-sample t-test
Glabal calculation : omit
Grand mean scaling : <no grand Mean scaling>
Global normalisation : <no global narmalisation
Parameters : 2 condition, +3 covariate, +0 block, 0 nusance
5 total, having 5 degrees of freedom
leaving 15 degrees of freedom from 20 images
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2. ANALYSIS AND VISUALISATION

Before we finish, it is a good idea to generate a population average brain for
projecting our data onto (because it is not precisely mni). To do this, we simply
warp the bias corrected T1s to our group average space. You can do this using
spm_warpshoot script on page 18. Make sure to input the following options:

* Tissueclass=1
* Modulation = 0 (i.e. no modulation)
 FWHM=000

All being well, this will generate a w[filename].nii in each folder.

Now to generate an average image, select Imcalc from the SPM menu:

SPM12 (6906): Menu

s midhds (wd SN WA WV
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File Edit View SPM BasiclO ¥
Dz E P
Module List Current Module: Image Calculator
Help on: Image Calculator ..
Input Images 20 files e——— Select w(filename].nii
Output Filename AVERAGE_BRAIN.nii &= T'ype: [NA ME].nii
Output Directory ..OMPLETED/adni2_baseline/ad/sub-001/anat/spme—— S)e/fect output dir
Expression mean(X) @ .
Additional Variables Type: mean(X)
Options
. Data Matrix Yes - read images into data MatfiX @ Change to Yes- read jmages into
. Masking No implicit zero mask .
. Interpolation Trilinear data matrix
. Data Type INT16 - signed short

Current Item: Expression

| Speciy... |

——

Example expressions (f):
* Mean of six images (select six images)
f="(i1+i2+i3+i4+i5+i6)/6"
* Make a binary mask image at threshold of 100

f="11>100"
* Make a mask from one image and apply to another
f="i2.(1>100)"

- here the first image is used to make the mask, which is applied to the second image

This will read in all the w[filenames].nii and calculate a population average:
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Now onto looking at our results:

ONONO SPM12 (6906): Menu

| Cor. t

M

' Dynamic Causal Modelling ‘

ETE LI @) &
N B B
B M0 B BT

This will open a file select, you need to go to your analysis folder and pick the
SPM.mat

Following this, the contrast manager will open. Click “Define new contrast”
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SPM contrast manager

Enter a name.

To test for regions of the brain significantly bigger in group 1 vs. group 2, enter 1
-1 into the contrast, then click ok. To do the opposite analysis (group 2 regions >
group 1) enter -1 1.

Then:

* Apply masking: None (or enter a mask if you have one)
* Correction: FWE

* Pvalue: 0.05

* Extent threshold: 0

SPM12 (6906): Stats: Results
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The next window displays any results that survive FWE correction at P < 0.05,
displayed on a glass brain.

If you want to see these results on an actual MR, click (overlay) and select
“sections” and then input the average brain you just calculated.

File Edit View Insert Tools Desktop Window SPM Figur¢ Help

e g AD < HC
< (e <] u
u [ Nor.. %] = contrast
g | cor. %| T Segment E Wl e
r |
[ Basic models ‘ l Review ‘
l Estimate ‘ ’ Bayesian ‘ o
’ ’
[ l Results ‘ J SPM{TH}
u < :
g -
Design Contrasts Atlas
1 2 3 4 5
Design matrix
Statistics: p-valves adjusted for search volume
set-level cluster -level peakc-level [ —
L £ Prvecor Froeconr ‘( Purceer Prvecor Froeceer T 1Z) Purcerr
ﬁ 000 ¢ 200 o.am @ oo som  0em  mae s 0.00 -3 -2
aom  sem 3 odm  oem  eie  ma) %M g4 -M -3 9
aom  sam 3 o2m  oom  cak 220 52 9900 -4 -16 24
aom  sam 2 eam  oem  sak a8 sm  sem @ -3 4
aew  ean 2 eam  oem  cak 293 sa;  29e 3 -0 43
aom  eam 2 eam e oAk a4 %1 290 -a -26 6
wholebrain || [eigenvari...|[ VA || [
current cluster | multivariate Bayes |
[ smaltvotume || [ = [ pawe |
o= 000] p=[ o00] ==[ouo]| |
;Z Current... ® &  Command Window
I Name a i shows 3 facal mavima more than &.0mm apart
151 beta 000 SPM present work Meght freshold: T « 4.79, p « 0.000 {0.0%) Degrees of freedom = (1.0, 13.0)
— L) U Extent fweshold: k « 0 voxds FWHM « 12,1 22118 mm mm mm; 3.0 8.1 7.8 {voxels]
16 b 000 / Sers/c Expected voxels per clister, <k> « 2.714 Volume: 3479757 « 01031 voxels « 1949.3 resels
eta_ LUl Expected number of dusters, <>« 003 Voxel szez 1.3 1.3 1.3 mm mm mm; fresel « 310.96 voxels)
17 i beta 000 FWEp: 8.783, FORp: I, PWEC: 2, FORc: 31
18 - - ’ SPM12: spm_check
- beta 000... pm_
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If you want to change the contrast, or inspect a different threshold (P < 0.001
uncorrected), use the Contrasts menu:

Control > Alzheimer’s
You can save your thresholded SPM result in the save menu (the one under the

overlay menu (arrow)). You can then use your data visualization program of
choice to generate results.
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